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Introduction
Introduction
TNR-e is an iPhone/iPad application for creating electronic music. It was developed by Yamaha based on both its popular 
TENORI-ON device and the TNR-i iPhone/iPad application.
TNR-e has a wide variety of new, exciting sounds and functions specifically for use in electronic music, and lets you enjoy the 
highly intuitive, “visible” musical world of the TENORI-ON on your iPhone/iPad.
This Quick Guide covers the basic operations of the TNR-e. If you want to know more detailed information about this application, 
please read the TENORI-ON manual, available from the following URL.
http://www.global.yamaha.com/tenori-on/downloads/

Controls 

[ZOOM] button
While holding the [ZOOM] button, you can execute the following display operations.
• To zoom in: With your thumb and index finger apart on the display, “pinch” them together.
• To zoom out: With your thumb and index finger together on the display, move them apart.
• To scroll: Run your finger laterally or horizontally on the display.
Double-tapping the [ZOOM] button is equivalent to holding it. Holding is canceled by tapping the button again.

[EFFECT] button
Tap this to call up the XY Pad window (page 16). In the window, you can control the Master Effect and modulate the sound in many dynamic 
ways.
Tapping this button again while the XY Pad is displayed closes the window.

The “L” function buttons
[L1] button
[L2] button
[L3] button
[L4] button
[L5] button

[CLEAR] button LED buttons

Display

[START/STOP] 
button

The “R” function buttons
[R1] button
[R2] button
[R3] button
[R4] button
[R5] button

[ZOOM] button [EFFECT] button
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Basic Operation: Score Mode
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Loop indicator Active note

Loop indicator

Active notes will play and flash when 
the loop indicator passes over them.

The six modes

• Score mode
• Random mode 
• Draw mode 
• Bounce mode 
• Push mode 
• Solo mode 
Basic Operation: Score Mode

TNR-e “Modes”
The TNR-e 16 x 16 LED button matrix is simultaneously a performance 
input controller and display. By operating and interacting with LED 
buttons and the light they produce you gain access to the TNR-e’s 
numerous performance capabilities.
The TNR-e provides six different performance and sound/light modes 
for broad performance versatility, and these modes can be combined 
and used simultaneously for rich, complex musical expression.

The Score Mode
The Score mode is the basic TNR-e performance mode. In this mode 
the TNR-e interface functions like a musical “score” on which you can 
write the notes to be played in one musical measure via the 16 x 16 
LED button matrix. The time axis of the score proceeds from left to right 
(the horizontal axis), beginning at the left edge of the matrix and then 
looping back to the beginning once the right edge of the matrix is 
reached. The vertical axis corresponds to the pitch of the notes played. 
If more than one note is entered on the same vertical line, for example, 
those notes will be played simultaneously as an interval or chord. The 
maximum number of notes or intervals/chords that can be entered 
horizontally is 16, but within that range the number and playback 
speed can be set as required, allowing the creation of complex 
groupings when multiple Score-Mode layers are combined.

Performance in the Score Mode
Tap an LED button to play the sound assigned to it. At the same time 
the lights will flash outward from the played sound. If you hold the LED 
button a bit longer it will remain lit and will become an active note that 
will play repeatedly. Touch and hold an active note to de-activate it. 
The loop indicator will be continuously cycling from the left to right 
edge of the LED button matrix. Active notes will play when the loop 
indicator coincides with their positions on the matrix. 

 Tap the [CLEAR] button to de-activate all active notes of the current layer. 
TNR-e Quick Guide 3



Basic Operation: Score Mode

Touch and hold
[R4] buttonDrag the dial

e

me

Increase volume

Decrease volume

[START/STOP] button

Current loop indicator 
Layer volum

Master volu

Master Volume Adjustment
To adjust the overall volume of the TNR-e, drag the jog dial while 
holding the [R4] function button. The volume setting will appear in the 
Display.

Pausing Loop Playback
Tap the [START/STOP] while the highlighted “STOP” indicator in the 
lower right corner of the Display is shown to temporarily pause loop 
playback. 
The loop indicator will stop at the position at which the [START/STOP] 
is tapped, and the highlighted “STOP” indicator will change to 
“START.” Tap the [START/STOP] a second time and loop playback will 
resume from the point at which it was paused. 
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Function Buttons

The “L” function buttons The “R” function buttons

Touching the [L1] – [L5] or [R1] – [R5] function 
buttons will call up the jog dial. You can use this jog 
dial to set the value of the current function.

07/13

16/1616/01

01/1601/01

16
15
14
13
12
11
10
09
08
07
06
05
04
03
02
01

01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16

Matrix with voice number 07/13 selected.

LongerShorter
Function Buttons

Functions
By holding one of the ten function buttons of the TNR-e and operating 
the LED buttons you can change voices, change octaves, and apply a 
variety of effects and variations to your performance.
This unique visual/tactile interface has been specifically designed to
allow intuitive, instantaneous operation of a variety of functions. 

 Double-tapping the Function button is equivalent to holding it.

[L1] + LED buttons Changing Voices
You can select any voice from the 256 voices available in one quick 
operation. When you touch and hold the [L1] button, vertical and 
horizontal lines will light on the matrix, and the button at their 
intersection corresponds to the currently selected voice. If you tap a 
different LED button while these crossed lines are showing the 
intersection will move to that button and the corresponding voice will 
be selected. 

 The Voice number and name will appear in the Display. The Voice number 
corresponds to the vertical and horizontal button numbers.

 TNR-e has 253 Preset Voices and 3 User Voices.

[L2] + LED buttons Changing Note Length
Sets the length of the notes from the time they are triggered to the time 
they decay to silence (the gate time).
While holding the [L2] button, slide your finger horizontally over the 
matrix to move the lit vertical line to the desired setting. Moving the line 
to the right increases the note length. 

 Not available in the Push Mode.

Voice number (vertical/horizontal position)

Voice name
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Function Buttons

+5

-5

16

01

Layer
[L3] + LED buttons Changing Octaves
Sets the playback pitch in octave increments.
While holding the [L3] button, slide your finger vertically over the matrix 
to move the lit horizontal line to the desired octave. 

[L4] + LED buttons Changing Loop Points
Sets the loop playback range in the Score Mode.
While holding the [L4] button, slide your finger horizontally over upper 
half of the matrix to move the loop start point indicator to the desired 
point, and slide your finger horizontally over lower half of the matrix to 
move the loop end point indicator to the desired point, as required. 

 In the Random Mode this function sets the rotation direction and speed.

 Not available in the Draw, Bounce, Push and Solo Modes.

[L5] + LED buttons Changing Loop Speed
Sets the loop playback speed (the duration of the beats).
Four settings are available, set via the leftmost four columns on the 
matrix: quarter notes, eighth notes, sixteenth notes, and thirty-second 
notes. 
While holding the [L5] button, tap a button in the corresponding 
column.

 Not available in the Push Mode.

[R1] + LED buttons Switching Layers
Switches to a different layer.
While holding the [R1] button, slide your finger vertically over the matrix 
to move the lit horizontal line to the desired layer.
Moving the line to the lowest row selects layer 01, the next row up is 
layer 02, then layer 03, and so on up to layer 16. 
TNR-e Quick Guide 6



Function Buttons

FasterSlower

+8

-7

Higher

Lower

16

01

Layer

Higher 
volume

Lower
volume

1601
Block
[R2] + LED buttons Changing Tempo
Sets the playback tempo (BPM).
While holding the [R2] button, slide your finger horizontally over the 
matrix to move the lit vertical line to the desired tempo setting. Moving 
the line to the right produces faster tempos. 

[R3] + LED buttons Transposition
Adjusts the playback pitch in semitone increments.
While holding the [R3] button, slide your finger vertically over the matrix 
to move the lit horizontal line to the desired pitch.

[R4] + LED buttons Changing the Layer Volume
Displays the individual volume settings of all 16 layers, and allows the 
volume of each layer to be adjusted as required to create the ideal 
“mix” between layers.
Each row of LED buttons corresponds to a layer, beginning with layer 
01 at the bottom row.
While holding the [R4] button, slide your finger horizontally over the row 
corresponding to the layer you want to adjust to set the volume as 
required. Each LED button row corresponds to a layer (01 – 16 from 
bottom to top), and the horizontal axis corresponds to volume level
with volume increasing towards the right (the leftmost setting 
corresponds to “0” volume). 

 You can also use the jog dial to set the overall (Master) volume (the Master 
volume setting will appear in the Display).

[R5] + LED buttons Switching Blocks
Switches to a different block.
While holding the [R5] button, slide your finger horizontally over the 
matrix to move the lit vertical line to the desired block.
Moving the line to the leftmost column selects block 01, the next 
column to the right is block 02, then block 03, and so on up to block 
16. 

 You can copy the contents of the current block to another block.
TNR-e Quick Guide 7



Layers and the Performance Modes
Layers and the Performance Modes

Layers
TNR-e layers can be thought of as “performance parts” or “recording tracks.” The TNR-e has a total of 16 layers.
Separate notes and voices can be assigned to each layer, and all layers can be played together in synchronization.
The 16 layers are divided into six performance mode groups as shown in the illustration below. The six modes have different 
note entry methods and operation. Up to 16 layers created using different modes can be combined for rich, complex musical 
expression.

Blocks
One complete set of 16 layers is called a “block.” The TNR-e can store up to 16 programmed blocks (16-layer groups) in 
memory, and you can switch from block to block instantly during performance.
You could, for example, create a musical composition in one block, then copy that composition to another block and edit it to 
create a variation of the original composition. Or you can load a number of previously-created compositions into separate blocks 
and switch between them to create variation during playback.

 When you switch between layers or blocks, the current layer number, performance mode, and block number will appear in the Display.

 Tap the [CLEAR] button to clear all active notes from all layers and blocks.

Layer number

Performance mode

Block number

01 02 03 04

05 06 070201 03 04 08 09 10 11 12 13 14 15 16

15 16

Layers

Blocks

Performance mode: Score mode Random 
mode

Draw 
mode

Bounce 
mode

Push 
mode

Solo 
mode
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Layers and the Performance Modes
In the initial state, the six performance modes are assigned to the 16 layers as shown in the illustration below.

For example, if you tap any LED button in the eighth row from the bottom (any button in this row will do) while holding the [R1] 
function button as shown in the illustration, you will select the first Random mode layer.

 16 

 15 

 14 

 13 

 12 
 11
 10 

 09
 08
 07
 06 
 05
 04 

 03
 02
 01

Layer number Performance mode

Solo mode

Push mode

Bounce mode

Draw mode

Random mode

Score mode

Layer number

Performance mode
TNR-e Quick Guide 9



Random Mode Performance
Random Mode Performance
If you touch an LED button long enough to enter an active note in the Random mode, the active note will play back repeatedly. If 
you then enter a few more active notes, the lights will “travel” from note to note, in the order entered, and the active notes will 
sound when the traveling light passes over them. The Random mode thus produces a totally different type of loop from the 
Score mode.

Pitch

Higher

Lower

Active notes can be individually deactivated by 
touching and holding the corresponding LED button.
TNR-e Quick Guide 10



Draw Mode Performance
You can even spin loop-shapes you create in the Random mode by holding the [L4] button and running a finger around the 
matrix in the direction and at the speed of the desired spin. The pitches of the notes will change accordingly as the shape spins, 
producing loop sound effects. To stop rotation, touch and hold the LED button or double-tap the LED button while holding the 
[L4] button.

Draw Mode Performance
In this mode you can tap individual LED buttons or draw lines or curves on the matrix, and those actions will be played back and 
repeated. You can keep adding to your “composition” during playback to build up thick sonic textures.
In the Draw mode you cannot clear only a part of the performance. The entire layer can be cleared by tapping the [CLEAR] 
button.

Holding the [L4] button
TNR-e Quick Guide 11



Bounce Mode Performance (Layer 14) / Push Mode Performance (Layer 15)
Bounce Mode Performance
Tap an LED button and the light will “drop” from that button, bounce back from the bottom of the matrix, and repeat. The 
corresponding note will sound when the light bounces at the bottom row. The higher the entry point, the longer the interval 
between the sound. In the Bounce mode the pitches are arranged horizontally, like a piano, with the lowest pitch on the left and 
the highest on the right.

Bouncing can be individually stopped in any column by simply tapping the lowest LED button in that column.

Push Mode Performance
In this mode if you touch and hold an LED button the sound of the corresponding note will begin to change gradually while the 
flashing surrounding that button gets brighter and wider. If the button is held briefly the note and flashing will stop when you 
release it, but if you hold the button for longer the note and flashing will continue even after the button is released.

Pitch

Stop a note by tapping 
the central LED button.
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Solo Mode Performance
Solo Mode Performance
Touch an LED button and the corresponding note will repeat until the button is released. In the Solo mode the pitches are 
arranged horizontally, like a piano. You can change the interval between repeats by touching or sliding your finger to a lower 
(longer) or higher (shorter) LED button in the column. If you touch the lowest LED button in a column the note will sound once 
without any repeats.

If you turn the Quantize function ON, note timing in the Solo Mode will be synchronized to the Score Mode, making it easy to 
play solos with rhythm matching that of a background playing in the Score Mode layers. Refer to “Quantize” in the TENORI-ON 
Manual.

Pitch
TNR-e Quick Guide 13



Using Blocks
Using Blocks

Some Ideas for Using Blocks
You can leave the current composition in memory while copying it to other blocks where it can be edited to create variations that 
you can switch between at any time. You could also create totally different compositions in different blocks, and then switch 
between them in real time for interesting, varied performances.

Switching Between Blocks
You can switch between blocks simply by holding the [R5] function button and tapping an LED button in the column 
corresponding to the block you want to switch to.

1601

01 02 03 04 15 16
Blocks

Block

Holding the 
[R5] button
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Using Blocks
Copying from Block to Block
You can copy either a single layer to a different block, or all layers from the current block to another block.

• Copying via the LED Buttons

1. Select the layer or block you want to copy.

2. Touch and hold the [R5] function button. The currently playing block will be displayed.

To Copy a Single Layer: 
While still holding the [R5] button, tap the lowest LED button in the lit column (the LEDs in the column will shine brighter), and 
then tap an LED button in the column corresponding to the block you want to copy to. The current layer from the source block 
will be copied to the same layer in the destination block.

To Copy All Layers: 
While still holding the [R5] button, tap the lowest LED button in the lit column twice (the LEDs in the column will shine brighter 
each time the button is tapped), and then touch an LED button in the column corresponding to the block you want to copy to. All 
layers from the source block will be copied to the destination block.

Tap the lowest LED button in the lit column
 Only the selected layer is copied.

Double-tap the lowest LED button in the lit column
 All layers are copied (the entire block).

Holding the [R5] button Holding the [R5] button

Tap an LED 
button in the 
column 
corresponding 
to the block you 
want to copy to.
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Effect Control
Effect Control

Tapping the [EFFECT] button calls up the Effect control display.
Touch or drag the XY Pad to turn the active Effect on.
The correspondence between each Effect type’s parameter and the location on the XY Pad is shown below.

Touching two points on the XY Pad (for example, with the index fingers on your left and right hands) cycles continuously 
between the two values/parameters.
The speed of the cycle can be specified by the [MOTION] button.
When the lock switch is set to on, the effect continues even after you release your fingers from the display; when the lock switch 
is set to off, the effect stops when you release your fingers.

[MOTION] button

Lock switch

XY Pad

Tap this to activate the Master Effect.
Tapping both the left and right buttons at the 
same time activates the two Master Effects 
simultaneously.
Sliding the button calls up the Effect list and 
lets you select the Master Effect type.

Cutoff

High Pass 
Filter

Low Pass 
Filter

R
es

on
an

ce

Decimation

D
ry

/W
et

C.Freq, M.Ratio, M.Index, LPF Freq

O
S

C
.V

ol
, L

P
F

 R
es

on
an

ce

LFO Freq

D
ry

/W
et

Delay Time

8th 16th 64th

128th

32nd

F
ee

db
ac

k

Loop Length

2nd 8th
64th16th4th

Low 
Solo

Mid
Solo

High
Solo

Low 
Mute

Mid
Mute

High
Mute

32nd

D
ry

/W
et

FILTER DECIMATOR DELAY

NOISE LOOPER ISOLATOR

FLANGER

128th
TNR-e Quick Guide 16



Using the Menu
Using the Menu

About the Menu
In addition to the wide range of control available via the function and LED buttons, a number of detailed settings can be made 
via the TNR-e menu, including tempo, clock display, file save/load and many more.

Basic Menu Operation

1. Tap the Display section at the bottom to call up the Top Menu.

2. Tap the desired menu item to call up the corresponding menu.

From the Menu display, you can execute the desired function or edit the desired parameter value. To exit from the Menu display, 
tap [Done] or any section outside the menu area.
TNR-e Quick Guide 17



Menu List
Menu List
Regarding menu items marked with an asterisk (*), refer to the TENORI-ON Manual PDF at the following URL.
http://www.global.yamaha.com/tenori-on/downloads/

Play Menu
Parameters that apply to all layers and blocks.

Master Tempo* Sets the master tempo.

Master Scale* Sets the master scale.
The “Major Pentatonic” and “User” scales are provided in the TNR-e, in addition to the scales of the 
hardware TENORI-ON. 

Master Transpose* Sets the transposition.

Master Loop Speed* Sets the loop speed (beat duration) for all layers.

Master Loop Point* Sets the loop range for all layers.

Reset Loop Timing Resets the playback position to the beginning of the loop.
 You can reset loop timing by holding the [L4] and tap the [R1] .

Mute Mutes sound output.
 You can control Mute on/off by holding the [R4] and tap the [L1] .

Swing Rate Sets the “swing” feel.
Produces a “swing” feel by shifting the timing of the back beats. The smaller the rate, the shorter the 
repeat interval with the previous LED button. A setting of “0” produces no swing.

 This function applies to Score mode layers only.

 When using a swing feel, changing the loop's point and speed, and inputting the performance 
data into layers other than Score mode, etc., may shift the timing between layers.

Range ..................-23 – 0 – +23

Default ................0

LED buttons.........No display

Color Sets the color of the active note LED.
Range ..................White, Blue, Purple, Pink, Red, Orange, Green, Blue Green

Function Color Sets the color of the function LED.
You can select the LED color which is shown when the function button [L1] – [R5] is touched.

Range ..................White, Blue, Purple, Pink, Red, Orange, Green, Blue Green

Indicator Color Sets the color of the loop indicator.
Range ..................White, Blue, Purple, Pink, Red, Orange, Green, Blue Green

Brightness Adjusts the brightness of the LED buttons
Move the slider rightward to increase brightness and leftward to lower it.
TNR-e Quick Guide 18
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Menu List
Layer Menu
Parameters that apply to the currently selected layer.

Sound Select Selects internal sound of TNR-e (Internal) or external sound of Inter-App Audio application 
(Instrument App).

Instrument* Selects the Voice.

When Sound Select is set to ‘Internal.’
Tap the “Instrument” in the menu to call up the 
Voice list. Scroll through the list by dragging, 
then select the desired Voice by tapping.

 User Voices are assigned to [01/16], [02/16], 
[03/16] on the Voice map.

When Sound Select is set to ‘Instrument 
App.’
The display shows the [i] button and the name 
of selected Instrument App. When Instrument 
App is not selected, ‘Not assigned’ is shown 
instead of the name. Tapping the name or ‘Not 
assigned’ calls up the Instrument App list 
where you can select your favorite Instrument 
App. Tapping the [i] button calls up the editor 
window of the selected Instrument App.

Volume* Sets the layer volume.

Loop Speed* Sets the loop speed.

Sound Length* Sets the gate time.

Panpot* Sets the stereo position of the sound.

Animation* Specifies the light animation.

Animation Direction Specifies the light animation.
Sets the motion direction of the light animation to “Expand” or “Shrink.”

Play Mode Specifies the performance mode of the layer.
Range ..................Score, Random, Draw, Bounce, Push, Solo

Voice map
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Menu List
Edit Menu
Data edit functions such as copy, clear, and reset.
 After executing the Edit function, the button indication will change to [Undo]. If you tap [Undo], you can undo the last executed function.

[Undo] itself will be canceled when you execute any of the following operations.
• Executing another function in the Edit Menu.
• Closing the Menu.
• Exiting from the Edit Menu.
• Keeping [Undo] active without conducting any operations for longer than fifteen seconds.

Preference Menu
Initial settings that apply to the entire instrument.

Copy this Block* Copies the current block to another one.
Tap this menu item to call up the corresponding display. Set the destination block number then tap 
[Copy] to execute this function.

Clear this Block* Clears the active notes for the current blocks.
Tap [Clear] in the Menu to execute the function.

Copy this Layer* Copies the layer.
Tap this menu item to call up the corresponding display. Set the destination Block number and Layer 
number, then tap [Copy] to execute this function.

Clear this Layer* Clears the active notes for the current layer.
Tap [Clear] in the Menu to execute the function.

Clear All Blocks* Clears the active notes from all blocks (all layers).
Tap [Clear] in the Menu to execute the function.

Reset All Blocks* Resets all blocks (all layers).
Tap [Reset] in the Menu to execute the function.

Quantize* Synchronizes Solo mode note timing with the Score mode.

Push Sensitivity* Sets LED-button touch time for note activation.

Master Tuning* Master tuning for the internal voices (MIDI tone generator).

Local Control* Turns internal tone generator output ON or OFF.

Synchronize* Synchronizes multiple instruments.

Loop Indicator* Displays or hides the loop indicator.

User Scale Setting Note Allows you to create your own scale.
Assigns a note name (such as C#3, A5, etc.) to 
each of the 16 scale note numbers.
Use the created scale by selecting the User by 
“Main Menu” > “Play Menu” > “Master Scale.”

Scale note number Note name

The selected scale note number is represented 
as the vertical axis of LED buttons on the Score/
Random/Draw mode and the horizontal axis of 
LED buttons on the Bounce/Push/Solo mode.
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Menu List
User Voice Settings Allows you to create your own voice.
You can create up to three User Voices.

 A User Voice can be selected on the 
“Instrument” Voice map by tapping [01/16], 
[02/16], [03/16] in the Layer menu.

Tapping a User Voice on the “User Voice 
Settings” window calls up a window for Note assignment as shown below.

For each User Voice, sixteen audio samples can be assigned to Notes 01 – 16, which correspond to 
the pitch of each layer. To hear the assigned audio sound, tap the desired Note number in the list.

Note window

Tapping here opens each Note window.

Tapping this allows you to load or save all sixteen 
Notes. Also, sampling data output via the TENORI-
ON User Voice Manager can be imported.

Imports .WAV files transferred via iTunes from 
a computer. 

Records audio signals input via the microphone of 
the iPad.
Shows the length of sound data. Maximum available 
sampling time is five seconds. If this is exceeded, 
the duration time is shown in red.

Touch and slide leftward or rightward to adjust 
the Trim area.

Executes Undo of the last operation.

Plays back the 
audio shown in 
the window.

Executes Normalize, which optimizes 
the entire level of the audio data.

Executes Trim, which removes 
the specified areas. 

Tapping here saves the edited sound data as 
a User Voice.

Imports the audio data made on another application. 
Before using this function, you should copy the audio 
data from another application to the clipboard.

Tapping the shown sound data calls up the “Copy/
Paste/Clear” menu.
Copy: Copies the sound data to the Clipboard.
Paste: Pastes the sound data from the Clipboard.
Clear: Clears the assigned sound data.
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Menu List
File Menu
Includes data file save, load, rename and delete functions.
The following types are available.

The file operations listed below can be applied to the above file types.
Tap the desired file type in the File Menu to call up the available file list, then execute the desired operation.

These icons are shown when the file type is one of the following: Song, All Blocks, Current Block, or Current Layer.

Save
1 Tap the [+] button.

 Tapping the [+] with the selected Song or Audio file will call up the Recording Menu.

Rename, Delete and Other Menus
2 Tap the [>] indicator.

Load
3 Tap the file name.

Delete
3 Flick the file name, then [Delete] will appear.

Audio Audio File operations

Song* Song File operations

All Blocks* All Blocks File operations

Current Block* Current Block File operations

Current Layer* Current Layer File operations

All Settings* All Settings File operations

Local Shows the files saved in your TNR-e.

Server Shows the last ten files you’ve uploaded. Scrolling downward shows the next latest ten uploaded files. You can 
narrow down the list of files by keyword searching.

Latest Shows the latest ten files on the server. Scrolling downward shows the next latest ten files. You can narrow down 
the list of files by keyword searching.

Hot Shows the ten files (on the server) that have been played back the most. Scrolling downward shows the next ten 
files. You can narrow down the list of files by keyword searching.
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Menu List
Load Tapping the desired file will call up the dialog. Tap the [Load] to execute the actual Load operation.

 During loading, no other operations, including Load Cancel, can be executed.

 This menu is not available when “Audio” is selected. 

Rename Tap [>] at the right of the file name to call up the File Rename display. From this display, tap the file name to call 
up the on-screen keyboard, then enter the desired name. After entering the name, tap [Rename] to execute the 
Rename function.

 If you’ve entered an already existing name and an error dialog appears, enter a different name.

Send Mail In the File Rename display called up via [>], tap [Send Mail] to start up the E-mail software. Enter the destination 
address, write or revise your message then tap [Send] to send the selected TNR-e file. If you want to cancel this 
operation, tap [Cancel] before tapping [Send].

 You will, of course, need to set up the network and E-mail software beforehand.

If the mail receiver has already installed the TNR-e to his/her iPhone/iPad, the received file can be played 
immediately on his/her iPhone/iPad by tapping [Click Here!].

 When the received file is opened from some other E-mail software, the file will be saved to the TNR-e folder 
with the name “IMPORTED.” If a file of the same name already exists, the file will be overwritten. Because of 
this, you should always change the names of received files from “ImportedFile.”

 This menu is not available when “Audio” is selected. 

Delete Tap [>] at the right of the file name to call up the new menu. Tap [Delete] in this menu to call up the confirmation 
dialog. Tap [Delete] in the dialog to execute the actual Delete operation. Or flick the desired file name to call up 
the [Delete] button. Tapping [Delete] will execute the Delete function. Tapping the area outside the [Delete] 
button cancels the [Delete] indication.

Save Tap [+] at the right of the navigation bar to call up the display for entering the file name. You can revise the 
default file name as desired. From this display, tap the file name to call up the on-screen keyboard, then enter 
the desired name. After entering the file name, tap [Save] to execute the Save operation.

 If you’ve entered an already existing file name and an error dialog appears, enter a different file name then tap 
[Save] again.

 Tapping the [+] with the selected Song or Audio file will call up the “Recording Menu.”

 During saving, no other operations, including Save Cancel, can be executed.

Upload To use the Upload function, select a file type in the File Menu and tap [>] at the right of the file name to call up a 
new window, in which [Upload] is shown.

Uploading the Audio files
Tap [Upload] to access SoundCloud.
To use SoundCloud, you will need to register your name. For details, refer to the SoundCloud page (URL below).
http://soundcloud.com/

Uploading the Song/All Blocks/Current Block/Current Layer files
Tap [upload] to access the TENORI-ON Server. To use the server, you will need to register your name. You can 
enter the title and comments of the file. The file can be uploaded with a “public” or “private” setting. Setting this 
to “public” allows other users to download your file, while “private” allows you to prevent your file from being 
downloaded by other users. The setting “public” or “private” can be updated after uploading. You should log in 
to TENORI-ON Server before updating. Tapping [Upload] without logging in the server calls up the log-in 
window. For details about logging in to TENORI-ON SERVER, refer to “TENORI-ON Server Account” of System 
Menu in this manual.

 This menu is unavailable when an Audio file or All Settings file is selected.

Copy You can copy the data of the Audio file to the clipboard, from which the copied data can be obtained by another 
iPad/iPhone application.
To use the Copy function, select “Audio” in the File Menu and tap [>] at the right of the file name to call up a new 
menu, in which [Copy] is shown.
Tap [Copy] to call up the Clipboard window and tap [Copy Audio] in the window to copy the data of the selected 
Audio file to the Clipboard.

 This menu is available only when “Audio” is selected.

Update Allows you to edit the title and comments of your file on the server.

1. Select a file type from Song, All Blocks, Current Block, or Current Layer to call up the file list window.

2. Tap [Server] beneath the file list window to call up the window of your files on the server.

3. Tap [>] at the right of the file name to call up a new window.

4. Edit the comments and title in the window, then tap [Update].

 This menu is unavailable when an Audio file or All Settings file is selected.
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Menu List
Effect Menu
Reverb and chorus effect settings.

Interior Menu
Settings not related to performance (clock, song playback).

System Menu
Includes Initialize and various other system-related operations.

Reverb Type* Sets the reverb effect type.

Reverb Param* Sets the reverb effect depth.

Chorus Type* Sets the chorus effect type.

Chorus Param* Sets the chorus effect depth.

Interior Start Begins operation of the specified Interior mode.
Tap [Start] in the Menu to immediately begin the operation specified at the “Interior Type” described 
below.

 The Menu is not available in the Interior mode.

Interior Type Selects the type of Interior mode operation.
Range

• Song(DEMO) .................. Plays the pre-programmed TNR-e Demo Song.

• Song(USER).................... Randomly plays Song files from iPhone/iPad.

• Clock............................... Displays the time on the TNR-e matrix.

• Clock+Song(DEMO)....... Displays the time on the TNR-e matrix while playing the pre-programmed TNR-e Demo 
Song.

• Clock+Song(USER) ........ Displays the time on the TNR-e matrix while randomly playing Song files from iPhone/
iPad.

Interior Time Sets the amount of time that must elapse before Interior mode begins.
If the time specified here elapses without any operation executed, the TNR-e will change to the 
Interior mode specified at “Interior Type.” If the TNR-e often changes to the Interior Mode 
inadvertently, you may want to set Interior Time to a longer value.

 Regarding actual operations, the TNR-e cannot recognize operations which do not affect the 
TNR-e sound output, such as simply changing the menu or editing but not finalizing the parameter 
value. This means that all your edits, performances or operations will be canceled if the TNR-e 
changes to the Interior mode. To prevent this from happening, you may want to set Interior Time to 
a longer value.

Time Signal ON/OFF* Determines whether the time signal will be played or not.

SaveAs Time Signal Saves the data in the current block for use as the time signal.

Owner Name* Entering the name of the TNR-e owner
Tapping the owner name will call up the on-screen keyboard.

SaveAs Default* Saving the current settings as start-up defaults
Tap [Save] in the menu to save the current settings.

Initialize TNR-e system reset
Tapping [Set] in the Menu will initialize the TNR-e.

Manual Calling up the TNR-e Quick Guide

TENORI-ON Website TENORI-ON Web appears in the Menu.

 You will need to connect your iPhone/iPad to the Internet.
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Menu List
SoundCloud Calling up the SoundCloud Audio Library window.

1 Shows the list of recorded sound data in your iPhone/iPad.

2 Shows the list of sound data files which have been downloaded from SoundCloud.

3 Shows the list of recorded sound data files which have been uploaded to SoundCloud.

4 Shows the list of your favorite sound data files.

5 Shows all the uploaded sound data files for which Sharing has been set to “public.”

6 Sound data list displaying available data files for selection.

7 For connecting to SoundCloud.

8 Shows the available recording capacity.

9 Calls up the waveform of the currently selected sound data.

) Plays back the sound data files selected in the list. When playing back sound data directly from 
SoundCloud, the playback sound is output only from the iPhone/iPad.

! When the Library window is displaying the data files of Local: Opens the SoundCloud Upload 
window. 
When the Library window is displaying the data files of SoundCloud: Downloads the selected 
file.

@ When the Library window is displaying the data files of Local: Copies the sound data selected 
in the list to the Clipboard. The sound data can be copied to other iPhone/iPad applications via 
the Clipboard.
When the Library window is displaying the data files of SoundCloud: Registers the currently 
selected sound data to Your Favorites or cancels the registration.

# Deletes the selected sound data file.

$ Calls up the information related to the currently selected sound data. If your original data is 
selected, you can edit the information with the keyboard.

% Closes the Library window.

TENORI-ON Server 
Account

The TENORI-ON Server and Twitter link with each other. Your Twitter account is necessary when 
using the server. To use the server, tap [Log In] to call up the Twitter Authorize application window, 
then enter your Twitter account and password. Your User Name and profile icon mirror those of your 
Twitter account. Log in status is maintained for a week.

Guide If you set the Guide function, holding the [L1] – [L5], [R1] – [R5] calls up the tutorial for each held 
button and indicates the row/column number of LED buttons.
Guide option can be selected from the following.
All: Indicates both tutorial for function button and row/column number of LED buttons.
Index: Indicates row/column number of LED button. Tutorial for [L1] – [L5], [R1] – [R5] is not 
indicated.
None: Neither the tutorial nor the row/column number of LED buttons are indicated.

Panel Lock Locks the LED buttons and panel operations of the TNR-e, and prevents inadvertent operations or 
changes. This is useful when you execute a multiplayer session via the TNR-e while controlling the 
hardware TENORI-ON (TNR-W/TNR-O).

1
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Bounce Mode Performance (Layer 14) / Push Mode Performance (Layer 15)
Recording Menu
Includes recording and saving recorded files.

Performance operations carried out on the TNR-e can be recorded in real time and saved as a Song or Audio file. Song files 
contain all operations carried out from the time recording is begun until it is ended: LED button operations, functions button 
operations, and [CLEAR] operations are all recorded in real time. A recorded Song file can then be loaded into the TNR-e and 
played back, precisely reproducing the entire performance as it occurred.
On the other hand, Audio files contain all the sounds produced via the TNR-e performance and input via the iPad microphone.
From the File menu, an Audio file can be uploaded to the SoundCloud, and can be copied to other iPhone/iPad applications via 
the Clipboard.

 Song files can be loaded from the File Menu.

 Uploading of Audio files to SoundCloud and copying of Audio files to Clipboard are both available in the File Menu.

 To use SoundCloud, access the following URL, then register your name.
http://soundcloud.com/

 XY Pad operations (called up by the [EFFECT] button) are not recorded to the Song file.

Recording For recording and saving a Song.

1. Tap “Display” > “Recording Menu,” then select [Song] and tap [Start] in the menu to begin 
recording.

 The Menus cannot be accessed during recording.

2. When the performance is finished, tap [START/STOP] to stop recording.

3. After confirming the message “Save this Song?,” tap [OK] as desired.
If you do not want to save, execute any of the following operations.
• Tap [Cancel].
• Tap the area outside the menu.
• Tap [Top Menu] in the Recording Menu.
• Tap [Done] in the Recording Menu.

 If you tap [START/STOP], the already-recorded data is canceled and you can start re-
recording.

4. If you tap [OK] in step 3 and the Song file name entry display appears, enter the desired file 
name.

 Tapping the file name will call up the on-screen keyboard.

5. Tap [OK] at right of the file name to save the recorded data as a Song file.

For recording and saving Audio files.

1. Tap [Audio] in the Type menu.

2. Tap [Stand By] in the Recording menu to enable recording standby on the TNR-e.

3. Tap [START] in the upper right area of the display to start recording.

4. Tap [STOP] to stop recording and call up the window for the file operation in the upper right area 
of the display.

5. Tap [Save] to save the recorded data as an Audio file.
Tapping [Cancel] aborts saving of the file and closes the window.
Tapping the file name area calls up the on-screen keyboard and allows you to enter the file 
name. 

Tapping here starts recording of the audio 
signals input via the iPad microphone, as 
well as the audio signals produced via your 
TNR-e performance.
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Menu List
Session Menu
Operations related to sessions with other users.

Multiplayer Session For entering a Multiplayer Session.
Tapping [Start] starts the Multiplayer Session. The “Chat” indication appears in the menu when a 
session is active.

Chat Message For entering messages and showing the message history and member locations.
The “Chat” indication appears in the menu only when a session is active.
During a session, tap [Open] of “Chat” or tap the player name shown in the upper area of the display 
to call up the window. In this window, input the message, then tap [Send] to transmit the message to 
other session members and allow them to see your message on their iPad displays. You can also 
see the message history and locations of the members in the window.

Finding Players on Twitter For inviting session members via Twitter.
When this is set to ON, you will see messages from other users who have invited session members 
on the upper area of your TNR-e screen; these are displayed once every minute. When this is set to 
ON, enter the Multiplayer Session to call up the dialog. In this dialog, input a message to the Twitter 
site for inviting session members and tap [Send] to transmit the message to Twitter, which enables 
Session Standby status. To enter Session Standby status without transmitting the message to Twitter, 
tap [Cancel] instead of [Send]. The messages you have transmitted are shown on the TNR-e 
screens of other users who set “Finding Players on Twitter” to ON.

Sending Location For allowing your location information to be sent.
When you set this to ON, the other members can recognize your location in their TNR-e Chat 
window.

 You should also allow sending of your location in the iOS.

WIST For synchronizing with other applications.
You can synchronize your TNR-e performance with that of another iPad/iPhone application. Tap 
[Connect] of “WIST” in the menu to look for the target applications.
For details about WIST, tap “About WIST” in the menu or refer to the following URL.
http://www.korguser.net/wist/
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iPhone/iPad <–> Computer (iTunes) File Transfer
iPhone/iPad <–> Computer (iTunes) File Transfer
You can transfer TNR-e files from your iPhone/iPad to a computer, and vice versa.
By connecting your iPhone/iPad to a computer, you can also access your TNR-e files (saved in the File Menu) from iTunes on the 
computer, using the following operation.

iTunes  DEVICES  Your iPhone/iPad  App  File Sharing  TNR-e

Multiplayer Session
The Game Center lets you execute multiplayer sessions. In the TNR-e, different layers can be played by different players at the 
same time, such as Layers 1 – 4 for you and Layers 5 – 8 for your friend.

 To do this, follow the instructions below.
Sign In from the Game Center Menu to log in the Game Center with your Apple ID.
With your iPhone/iPad connected via Network, start the TNR-e to register your TNR-e to the Game Center. 
Once your TNR-e is registered to the Game Center, you can start the TNR-e from the Game Center menu from the next time.

Calling up a Multiplayer Game
Hold [CLEAR] then tap the Display section of TNR-e or call up the Multiplayer 
Game menu as shown at right. Also tapping [Start] at “Multiplayer Session” in 
the Session menu calls up the Multiplayer Game menu.
From this window, you can select the session players (up to three friends) via 
“Auto-Match” or “Invite Friend” (one-by-one).

 When you select the first session player: 
If you tap [Play Now] without any operation, the Game Center will search and 
determine another player, letting you start the TNR-e session. If you tap [Invite 
Friend], you can select your desired friend as the session player then tap [Play Now] 
to start the session. For details, refer to the next section. 

 When you select the second or third session player: 
Tap [Play Now], or tap [Invite Friends] to select your desired friend as the session 
player.

 When you remove the player: 
Tap [Remove Player]. 

Selecting another player and starting the Multiplayer Session
There are two ways to select another player.

1. Selecting another player with “Auto-Match.”
When the Multiplayer Game window is called up, “Auto-Match By Game Center” is shown as the player name. In this status, 
tapping [Play Now] will start the search to find a player who wants to join the session.

 The Game Center will determine the player who has also executed “Auto-Match.”

 Note that you should wait until the Game Center determines the player. If you don’t wish to wait, tap [Cancel].

2. Selecting another player with “Invite Friends.”

 Ask your friends to set the “Allow Game Invites” (called up via [Game Center] > Account > [View Account] > [Allow Game Invites]) of his/her 
account to on.

 Ask your friend to set “Notifications” (called up via [Setting] > [Notifications]) of iOS in his/her iPhone/iPad to on.

 Ask your friend to set “Alerts” (called up via [Setting] > [Notifications] > [Game Center]) of iOS in his/her iPhone/iPad to on.

1. Tap [Invite Friend] in the Multiplayer Game to call up your friends list.

2. Tap your desired friends in the list to enter checkmarks.

3. Tap [Next], enter a message to your friends as desired, then tap [Send] to send the invitation message to your friends’ 
iPhone/iPad.

 Your friends will receive your invitation message with a fanfare sound. Your friends may tap “Accept” to accept the invitation or tap “Decline” 
to reject the invitation. Your friends’ TNR-e will be started automatically when they tap “Accept.”
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Showing LED buttons in an external display
 In your iPhone/iPad, “Waiting…” will be shown until the answer comes from your friend. When your friend accepts your invitation, the “Ready” 
indication appears next to your friend’s name in the list. If there is no answer from your friend for a while, “No Answer” will appear and you can 
invite another friend.

4. Tap [Play Now] to start playing. You can play the TNR-e with your friends marked with “Ready.” You can start playing only 
after one friend has accepted your invitation.

 All the iPhones/iPads of the players should be connected via Network.

 Only you (the inviter) can start playing the Multiplayer Session.

 All the TNR-e settings of the players will be initialized when the Multiplayer Session starts.

 As soon as the Multiplayer Session is started, all the player’s Loop Indicators will be synchronized to the same position, allowing all the 
players to operate their TNR-e layer in sync with each other.

Operations on the Multiplayer Session
Basically, your performance generated by tapping or touching LED buttons will be transmitted to the other players. For 
information about other performances, note the following points.

 When the Multiplayer Session is started, all the player’s names will be displayed.

 The settings in “Play Menu,” “Layer Menu,” “File Menu” and “Effect Menu” will be applied to all the iPhones/iPads of the other players.

 The settings in “Preference Menu” will be applied to only your iPhone/iPad. This allows each player to make different settings, creating various 
sounds.

 UNDO is not available in “Edit Menu.”

 When you execute “Copy this Layer,” only your current Layer will be moved. That of the other players will not be moved.

 In the Multiplayer Session, the following Menus are not available.
• “File Menu”
• “Interior Menu”
• “System Menu”
• “Recording Menu”

 “Edit Menu” can be operated by only one player at the same time.

 Synchronization between the iPhones/iPads may be broken by editing “Master Tempo,” ”Master Loop Speed,” ”Master Loop Point Top,” and 
”Master Loop Point End” in “Play Menu.” If this happens inadvertently, touch [Reset] of “Reset Loop Timing.” Touching [Reset] for a while will 
enable high-resolution synchronization. Note that it is difficult to maintain synchronization if the network delay is large.

 Each player can select his or her own “Color” in the “Play Menu.” Changing the “Color” value will affect only your active notes.

 Once the TNR-e is closed or network communication errors occur with the other players, the Multiplayer Session will be ended and cannot be 
recovered.

 Before joining the session, make sure to upgrade your TNR-e to the latest version to play in the session successfully.

 WIST is unavailable when you are in a Multiplayer Session.

Exiting from Multiplayer Session
You can exit from a Multiplayer Session by the operation described below. The last status of the performance is not cleared by 
exiting the operation. You can save the performance data.

• Tap the [CLEAR] button while holding the [START/STOP] button.
• Tap [Exit] at “Multiplayer Session” in the Session menu.
• Exit TNR-e by pressing the [Home] button on your iPhone/iPad.

Showing LED buttons in an external display
The indication of TNR-e LED buttons can be output to an external display by connecting a hardware accessory (such as the 
Apple VGA adapter) to the Dock connector of your iPad. If your device supports AirPlay Mirroring, you can output the 
indications of the TNR-e LED buttons to an external display by AirPlay.
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AudioCopy and AudioPaste are trademarks and software of Sonoma Wire 
Works

KORG WIST (Wireless Sync-Start Technology) 
Software Development Kit
Copyright © 2011, KORG INC.
All rights reserved.

Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, 
this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright 
notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution.

3. Neither the name of KORG INC. nor the names of its contributors may be 
used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

SoundCloud API cocoa wrapper
Copyright 2009 Ullrich Schäfer, Gernot Poetsch for SoundCloud Ltd.

This product includes software developed by Ullrich Schäfer and Gernot 
Poetsch on behalf of SoundCloud Ltd.

SoundCloud API cocoa wrapper is released under Apache License 2.0.

Apache License
Version 2.0, January 2004
http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

“License” shall mean the terms and conditions for use, reproduction, and 
distribution as defined by Sections 1 through 9 of this document.

“Licensor” shall mean the copyright owner or entity authorized by the 
copyright owner that is granting the License.

“Legal Entity” shall mean the union of the acting entity and all other entities that 
control, are controlled by, or are under common control with that entity. For the 
purposes of this definition, “control” means (i) the power, direct or indirect, to 
cause the direction or management of such entity, whether by contract or 
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding 
shares, or (iii) beneficial ownership of such entity.

“You” (or “Your”) shall mean an individual or Legal Entity exercising 
permissions granted by this License.

“Source” form shall mean the preferred form for making modifications, 
including but not limited to software source code, documentation source, and 
configuration files.

“Object” form shall mean any form resulting from mechanical transformation or 
translation of a Source form, including but not limited to compiled object code, 
generated documentation, and conversions to other media types.

“Work” shall mean the work of authorship, whether in Source or Object form, 
made available under the License, as indicated by a copyright notice that is 
included in or attached to the work (an example is provided in the Appendix 
below).

“Derivative Works” shall mean any work, whether in Source or Object form, that 
is based on (or derived from) the Work and for which the editorial revisions, 
annotations, elaborations, or other modifications represent, as a whole, an 

original work of authorship. For the purposes of this License, Derivative Works 
shall not include works that remain separable from, or merely link (or bind by 
name) to the interfaces of, the Work and Derivative Works thereof.

“Contribution” shall mean any work of authorship, including the original version 
of the Work and any modifications or additions to that Work or Derivative Works 
thereof, that is intentionally submitted to Licensor for inclusion in the Work by 
the copyright owner or by an individual or Legal Entity authorized to submit on 
behalf of the copyright owner. For the purposes of this definition, “submitted” 
means any form of electronic, verbal, or written communication sent to the 
Licensor or its representatives, including but not limited to communication on 
electronic mailing lists, source code control systems, and issue tracking 
systems that are managed by, or on behalf of, the Licensor for the purpose of 
discussing and improving the Work, but excluding communication that is 
conspicuously marked or otherwise designated in writing by the copyright 
owner as “Not a Contribution.”

“Contributor” shall mean Licensor and any individual or Legal Entity on behalf 
of whom a Contribution has been received by Licensor and subsequently 
incorporated within the Work.

2. Grant of Copyright License. 
Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, 
irrevocable copyright license to reproduce, prepare Derivative Works of, 
publicly display, publicly perform, sublicense, and distribute the Work and 
such Derivative Works in Source or Object form.

3. Grant of Patent License. 
Subject to the terms and conditions of this License, each Contributor hereby 
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, 
irrevocable (except as stated in this section) patent license to make, have 
made, use, offer to sell, sell, import, and otherwise transfer the Work, where 
such license applies only to those patent claims licensable by such 
Contributor that are necessarily infringed by their Contribution(s) alone or by 
combination of their Contribution(s) with the Work to which such 
Contribution(s) was submitted. If You institute patent litigation against any 
entity (including a cross-claim or counterclaim in a lawsuit) alleging that the 
Work or a Contribution incorporated within the Work constitutes direct or 
contributory patent infringement, then any patent licenses granted to You 
under this License for that Work shall terminate as of the date such litigation is 
filed.

4. Redistribution. 
You may reproduce and distribute copies of the Work or Derivative Works 
thereof in any medium, with or without modifications, and in Source or Object 
form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a 
copy of this License; and

(b) You must cause any modified files to carry prominent notices stating 
that You changed the files; and

(c) You must retain, in the Source form of any Derivative Works that You 
distribute, all copyright, patent, trademark, and attribution notices 
from the Source form of the Work, excluding those notices that do not 
pertain to any part of the Derivative Works; and

(d) If the Work includes a “NOTICE” text file as part of its distribution, 
then any Derivative Works that You distribute must include a readable 
copy of the attribution notices contained within such NOTICE file, 
excluding those notices that do not pertain to any part of the 
Derivative Works, in at least one of the following places: within a 
NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative 
Works; or, within a display generated by the Derivative Works, if and 
wherever such third-party notices normally appear. The contents of 
the NOTICE file are for informational purposes only and do not modify 
the License. You may add Your own attribution notices within 
Derivative Works that You distribute, alongside or as an addendum to 
the NOTICE text from the Work, provided that such additional 
attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may 
provide additional or different license terms and conditions for use, 
reproduction, or distribution of Your modifications, or for any such Derivative 
Works as a whole, provided Your use, reproduction, and distribution of the 
Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. 
Unless You explicitly state otherwise, any Contribution intentionally submitted 
for inclusion in the Work by You to the Licensor shall be under the terms and 
conditions of this License, without any additional terms or conditions. 
Notwithstanding the above, nothing herein shall supersede or modify the 
terms of any separate license agreement you may have executed with 
Licensor regarding such Contributions.
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6. Trademarks. 
This License does not grant permission to use the trade names, trademarks, 
service marks, or product names of the Licensor, except as required for 
reasonable and customary use in describing the origin of the Work and 
reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. 
Unless required by applicable law or agreed to in writing, Licensor provides 
the Work (and each Contributor provides its Contributions) on an “AS IS” 
BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied, including, without limitation, any warranties or conditions of 
TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A 
PARTICULAR PURPOSE. You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks 
associated with Your exercise of permissions under this License.

8. Limitation of Liability. 
In no event and under no legal theory, whether in tort (including negligence), 
contract, or otherwise, unless required by applicable law (such as deliberate 
and grossly negligent acts) or agreed to in writing, shall any Contributor be 
liable to You for damages, including any direct, indirect, special, incidental, or 
consequential damages of any character arising as a result of this License or 
out of the use or inability to use the Work (including but not limited to damages 
for loss of goodwill, work stoppage, computer failure or malfunction, or any 
and all other commercial damages or losses), even if such Contributor has 
been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. 
While redistributing the Work or Derivative Works thereof, You may choose to 
offer, and charge a fee for, acceptance of support, warranty, indemnity, or 
other liability obligations and/or rights consistent with this License. However, in 
accepting such obligations, You may act only on Your own behalf and on Your 
sole responsibility, not on behalf of any other Contributor, and only if You agree 
to indemnify, defend, and hold each Contributor harmless for any liability 
incurred by, or claims asserted against, such Contributor by reason of your 
accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate 
notice, with the fields enclosed by brackets “[]” replaced with your own 
identifying information. (Don't include the brackets!) The text should be 
enclosed in the appropriate comment syntax for the file format. We also 
recommend that a file or class name and description of purpose be included 
on the same “printed page” as the copyright notice for easier identification 
within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the “License”); you may not 
use this file except in compliance with the License.
You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed 
under the License is distributed on an “AS IS” BASIS, WITHOUT WARRANTIES 
OR CONDITIONS OF ANY KIND, either express or implied.
See the License for the specific language governing permissions and 
limitations under the License.

Manual Development Department
©2013-2014 Yamaha Corporation
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